Digitally Controlled HV Solar MPPT DC-DC Converter Using C2000™ Piccolo™ Microcontroller

Shamim Choudhury

ABSTRACT
This application report presents the implementation details of a digitally controlled DC-DC converter that is used as a front-end converter for solar inverter (DC-AC) application. It implements an isolated DC-DC stage with maximum power point tracking (MPPT) algorithm in order to utilize the full capacity of a 500W solar panel. It maintains its input voltage at the reference set point generated by the MPPT algorithm and delivers power to a downstream DC-AC inverter when connected across its output. The DC-AC inverter transfers the power from the DC-DC stage to an emulated grid connected across its own output. A C2000 Piccolo-B control card and a 500W isolated DC-DC stage EVM are used to implement the complete DC-DC system.

This EVM comes with a Piccolo-B control card and not the Piccolo-A card. However, a Piccolo-A control card can also be used to implement full control of the EVM.

Contents
1 Introduction ................................................................................................................... 2
2 Software Overview ........................................................................................................ 5
3 Procedure for Running the Incremental Builds - All ..................................................... 8
4 References .................................................................................................................. 25

List of Figures
1 Isolated DC-DC Converter Block Diagram ................................................................. 2
2 MPPT DC-DC Converter Control Using C2000 Microcontroller ............................... 3
3 MPPT DC-DC Converter Control Loops .................................................................. 4
4 MPPT DC-DC Software Flow Diagram ................................................................... 5
5 Software Blocks ........................................................................................................ 6
6 Software Control Flow .............................................................................................. 7
7 Build 1 Software Blocks .......................................................................................... 9
8 PWM Generation and ADC Sampling ....................................................................... 10
9 Code Composer Studio Project Window ................................................................. 11
10 Build 2 Software Blocks ......................................................................................... 16
11 Interleaved Boost DC-DC Waveforms ...................................................................... 19
12 Build 3 Software Blocks ......................................................................................... 20
13 Sample Code ........................................................................................................ 23
14 LLC Stage Waveforms ........................................................................................... 24
15 DC-DC Boost Stage Waveforms ............................................................................. 24

List of Tables
1 Library Modules ......................................................................................................... 6
2 Incremental Build Options for MPPT DC-DC .......................................................... 8

C2000, Piccolo, Code Composer Studio are trademarks of Texas Instruments.
Photovoltaic (PV) systems based on solar energy offer an environmentally friendly source of electricity. A key feature of such PV system is the efficiency of conversion at which the power converter stage can extract the energy from the PV arrays and deliver to the load. The maximum power point tracking (MPPT) of the PV output for all sunshine conditions allows reduction of the cost of installation and maximizes the power output from the PV panel. Therefore, a DC-DC converter employing some MPPT algorithm is generally used as a front-end converter to efficiently extract the PV output power and convert the PV output voltage to a high voltage DC bus. The DC-DC converter, depending on the system requirement, can use either an isolated power stage or a non-isolated stage. The high voltage bus from the DC-DC converter is then fed to power the DC-AC inverter that eventually supplies the load and connects to the grid.

This C2000 MPPT DC-DC EVM uses an isolated DC-DC stage as is shown in Figure 1. It consists of two DC-DC stages: a 2-ph interleaved boost converter and an isolated half bridge LLC resonant converter.

The DC-DC converter draws dc current from the PV panel such that the panel operates at its maximum power transfer point. This requires maintaining the panel output, that is, the DC-DC converter input at a level determined by the MPPT algorithm. This is implemented in the 2-ph interleaved boost converter stage. The isolated LLC resonant converter simply provides high frequency isolation for the DC-DC stage.

A C2000 piccolo microcontroller with its on-chip PWM, ADC and analog comparator modules is able to implement complete digital control of such MPPT DC-DC system.
1.1 DC-DC Stage Implementation

Figure 2 illustrates a C2000-based MPPT DC-DC converter control system. The PV panel output voltage, \( V_{pv} \), is applied to the 2-ph interleaved boost stage.

Inductor \( L_1 \), MOSFET \( Q_1 \), and diode \( D_1 \) together form one of the boost stages while, \( L_2 \), \( Q_2 \), and \( D_2 \) form the other. A capacitor \( C_2 \) at the boost converter output acts as an energy reservoir and provides boost voltage to the resonant LLC stage.

The H bridge LLC resonant stage consists of MOSFETs \( Q_3 \)~\( Q_4 \), input capacitors \( C_3 \)~\( C_4 \), resonant inductor \( L_r \), resonant capacitor \( C_r \), transformer \( T_1 \), output rectifiers \( D_3 \)~\( D_6 \) and output capacitor \( C_5 \). This stage has a voltage ratio of 1 and provides the isolation between the primary and secondary side.

Figure 1 indicates all the interface signals needed for full control of this DC-DC converter using a C2000 micro-controller (MCU). The MCU controls the hardware using three feedback signals and four PWM outputs. The signals that are sensed and fed back to the MCU include the panel output voltage (\( V_{pv} \)) and the boost output voltage (\( V_{boost} \)) and the total boost inductor currents (\( I_{ind} \)). These sensed signals are used to implement the voltage and current control loops for the DC-DC boost stage. The interleaved boost DC/DC topology is chosen to boost the variable DC output to a fixed DC bus voltage. The main reason for using this topology is the wide input voltage variation. The PWM signals for the power switches \( Q_1 \) and \( Q_2 \) is phase-shifted by 180 degrees. This helps reduce the ripple in the PV panel current.

The LLC stage runs at open loop with its PWM frequency set to be the same as the resonant frequency. The Piccolo controller shares the common ground with the primary side of the LLC stage and there is no isolated feedback to the controller from the LLC secondary output terminals. Thus the LLC is run under open loop and, therefore, it is necessary to maintain a voltage conversion factor of 1. This is achieved by:

- Making the LLC PWM frequency the same as the resonant frequency
- Maintaining a minimum load of about 10W across the LLC output

Figure 3 shows the DC-DC interleaved boost converter control loops. This uses current mode control. However, the goal is to control the PV panel output (\( V_{pv} \)), which is the input to the DC-DC stage. This allows the PV panel (array) operates at its maximum power point at all time. Input current is regulated by adjusting the duty cycles of the power switches \( Q_1 \) and \( Q_2 \). Input voltage is regulated by adjusting the input current. A maximum power point tracking algorithm described in the next section is responsible for determining the set point (\( V_{pv\_ref} \)) for the PV panel voltage.
Notice that the input voltage control loop works quite differently compared to conventional feedback used in output voltage control. Under this control scheme, when the PV panel voltage (V_pv) tends to go higher than the reference panel voltage (V_pv_ref) set by the MPPT algorithm, the control loop increases the panel current command (reference current for inner current loop I_ind_ref) and, thereby, controls the panel voltage at its reference level (V_pv_ref). When the panel voltage tends to go lower than the reference, the control loop reduces the panel current command in order to reestablish the panel voltage to its reference level.

The panel voltage V_pv, sensed through one of the ADC channels, is compared against the reference voltage V_pv_ref set by the MPPT algorithm. The resulting error signal E_v is then input the voltage loop controller G_v which regulates the panel voltage at the reference level. The voltage controller G_v has the form of a two-pole two-zero (2P2Z) compensator. The output of G_v is the reference current command for the inner inductor current loop. The average value of the inductor current is the panel current I_pv.

Therefore, by controlling the average value of the inductor current the current controller G_c essentially controls the panel current.

This reference current command I_ind_ref for the current control loop is compared against the feedback inductor current I_ind sensed through another ADC channel. The resulting current error signal is then input the current loop controller G_c which generates the boost converter PWM duty ratio command d for the boost switches Q1 and Q2.

In addition to implementing the voltage and current loop controllers, C2000 MCU also monitors the boost output voltage for over voltage protection. The ADC channel that monitors the boost voltage has an internal analog comparator with user programmable threshold. This threshold for the comparator is set by use of an internal 10-bit DAC. Whenever the DC bus voltage reaches an upper limit corresponding to the user programmable comparator threshold, the comparator initiates a pulse by pulse duty limit for the boost PWM signals. This limits the boost inductor current and hence the boost bus voltage to its desired upper limit.

C2000 MCU also generates two PWM outputs to drive the isolated LLC stage. This stage is run in an open loop fashion with unity voltage conversion ratio (voltage gain). This means the boost voltage and the LLC output voltage V_bus is almost equal. However, this requires a small minimum load of about 10W across V_bus (16kΩ at 400 V). With no load connected across V_bus and the boost output voltage set to 400V, the LLC stage gain might be higher than 1, resulting in high voltage across LLC output (V_bus). You must prevent this condition by always maintaining a minimum load resistor of about 16kΩ across the LLC output (V_bus).

All the time critical functions related to the DC-DC control loops are implemented in a fast sampling loop enabled by the C2000 Micro-controller high speed CPU, interrupts, on chip 12-bit ADC module and high frequency PWM modules. A detailed description of the software algorithm is provided in the following sections.

1.2 DC-DC Electrical Specifications

The following lists the key highlights of the C2000 MPPT DC-DC EVM.

- Panel Voltage: 200V (Min) to 300 V (Max)
- 400 Vdc Output
- 500 Watts Output Power
- Full Load efficiency greater than 94%
2 Software Overview

2.1 Software Control Flow

The Code Composer Studio™ project for C2000 MPPT DC-DC mostly makes use of the “Cbackground/ASM-ISR” framework. The main fast ISR (50 kHz) runs in assembly environment. However, a slower ISR (10 kHz) is also run from C environment. This slow ISR is made interruptible by the fast ISR. Also, a third ISR runs from C environment at a much slower frequency to implement the local interconnect network (LIN) based communication with the DC-AC inverter stage. The frequency of the LIN interrupt is set by the inverter at 50Hz.

![Software Flow Diagram](image)

Figure 4. MPPT DC-DC Software Flow Diagram

The project uses C-code as the main supporting program for the application, and is responsible for all system management tasks, decision making, intelligence, and host interaction. The assembly code is strictly limited to the fast Interrupt Service Routine (ISR), which runs all the critical control code. Typically this includes reading ADC values, control calculations, and PWM updates. The slower ISRs in the C environment implement the MPPT algorithm to calculate the reference PV panel voltage and establish LIN communication with the inverter stage. Figure 4 depicts the general software flow for this project.

The key framework C files used in this project are:

- **HV_Solar_DC-DC-Main.c**: This file is used to initialize, run, and manage the application.
- **HV_Solar_DC-DC-DevInit_F2803x.c**: The controlCard (2803x) used in the MPPT DCDC EVM one of these files will be in the Code Composer Studio project. This file is responsible for a one time initialization and configuration of the F280xx device, and includes functions such as setting up the clocks, PLL, GPIO, and so forth.

The fast ISR consists of a single file:
- **HV_Solar_DC-DC-DPL-ISR.asm**: This file contains all time critical “control type” code. This file has an initialization section (one time execute) and a run-time section that executes at half the rate (50 kHz) as the PWM time-base (100kHz) used to trigger it.

The slow ISR that runs at 10kHz consists of two files. The user selects one of the two files to implement the MPPT algorithm.
Software Overview

- **Mppt_incc.h**: This file contains code for calculating the panel voltage for maximum power point tracking using the incremental conductance method. This file has an initialization section (one time execute) and a run-time section which executes at 10 kHz rate.

- **Mppt_pno.h**: This file contains code for calculating the panel voltage for maximum power point tracking using the perturb and observe method. This file has an initialization section (one time execute) and a run-time section which executes at 10 kHz rate.

The second slow ISR that runs at 50 Hz consists of one file.

- **SolarHv_DCDC_Lin.C**: This file contains code for establishing LIN communication with the inverter stage.

The Power Library functions (modules) are “called” from the fast ISR framework.

These power library modules may have both a C and an assembly component. In this project, five library modules are used. The C and corresponding assembly module names are:

**Table 1. Library Modules**

<table>
<thead>
<tr>
<th>C Configure Function</th>
<th>ASM Initialization Macro</th>
<th>ASM Run-Time macro</th>
</tr>
</thead>
<tbody>
<tr>
<td>PWM_1ch_UpDwnCnt_Cnf.c</td>
<td>PWMDRV_1ch_UpDwnCnt_INIT n</td>
<td>PWMDRV_1ch_UpDwnCnt n</td>
</tr>
<tr>
<td>ADC_SOC_Cnf.c</td>
<td>ADCDRV_1ch_INIT m,n,p,q</td>
<td>ADCDRV_1ch m,n,p,q</td>
</tr>
<tr>
<td>PWM_CompPairDB_Cnf.c</td>
<td>MATH_EMAVG_INIT n</td>
<td>MATH_EMAVG n</td>
</tr>
<tr>
<td></td>
<td>CNTL_2P2Z_INIT n</td>
<td>CNTL_2P2Z n</td>
</tr>
</tbody>
</table>

The assembly modules can also be represented graphically as shown in **Figure 5**.

![Software Blocks Diagram](image-url)
Note the color coding used for the modules in Figure 5. The blocks in ‘dark blue’ represent the on-chip hardware modules in C2000 controller. The blocks in ‘blue’ are the software drivers associated with these modules. The blocks in ‘yellow’ are part of the computation carried out on various signals. The controllers used for voltage and current loops have the form of a 2-pole 2-zero compensator. However, these can be of other forms such as, PI, PID, 3-pole 3-zero or any other controller suitable for the application. The modular library structure makes it convenient to visualize and understand the complete system software flow as shown in Figure 6. It also allows for easy use and additions/deletions of various functionalities. This fact is amply demonstrated in this project by implementing an incremental build approach. This is discussed in more detail in the next section.

Figure 6. Software Control Flow

As mentioned in Section 1.1, the MPPT DC-DC system is controlled by two feedback loops. The outer voltage loop maintains the panel voltage at the level calculated by the MPPT algorithm, while a faster inner current loop control the average boost inductor current. Figure 6 also gives the rate at which the software modules are executed. For example, the current controller is executed at a rate of 50 kHz (half of the PWM switching frequency) while the voltage controller is executed at 25 kHz rate.

### 2.2 Incremental Builds

This project is divided into three incremental builds. This approach provides the user with a step-by-step method to get familiar with the software and understand how it interacts with the MPPT DC-DC hardware. This approach also simplifies the task of debugging and testing the boards.

The build options are shown in Table 2. To select a particular build option set INCR BUILD, found in the HV_Solar_DC-DC-Settings.h file, to the corresponding build selection as shown in Table 2. Once the build option is selected, compile the complete project by selecting rebuild-all compiler option. The next section provides more details on how to run each of the build options.
Table 2. Incremental Build Options for MPPT DC-DC

<table>
<thead>
<tr>
<th>Incremental Build Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>INCR_BUILD = 1</td>
<td>Open loop check for boost and LLC action and ADC feedback (check sensing circuitry)</td>
</tr>
<tr>
<td>INCR_BUILD = 2</td>
<td>Open voltage loop and closed current loop control of boost</td>
</tr>
<tr>
<td>INCR_BUILD = 3</td>
<td>Closed voltage and current loop control of boost with MPPT</td>
</tr>
</tbody>
</table>

3 Procedure for Running the Incremental Builds - All

All software files related to this C2x controlled MPPT DC-DC system (the main source files, ISR assembly files and the project file for C framework) are located in the directory www.ti.com/controlsuite - (development_kits\MPPT DC-DC_v1.0\MPPT DC-DC). The projects included with this software are targeted for Code Composer Studio v4.

CAUTION

There are high voltages present on the board. It should only be handled by experienced power supply professionals in a lab environment. To safely evaluate this board a PV panel emulator with appropriate power rating should be used to power the unit. Before power is applied to the board a voltmeter and an appropriate resistive or electronic load should be attached to the output. This discharges the bus capacitor quickly when the PV power is turned off. There is no output over current protection implemented on the board and so you should take appropriate measures for preventing any output short circuit condition.

The following steps are used to build and run the example included in the DC-DC software.

3.1 Build 1: Open Loop Boost With ADC Measurements

3.1.1 Objective

The objectives of this build are:

- Evaluate MPPT DC-DC PWM and ADC software driver modules
- Verify MOSFET gate driver circuit, voltage and current sensing circuit
- Become familiar with the operation of Code Composer Studio

Under this build, the system runs in open-loop mode so the measured ADC values are used for circuit verification and instrumentation purposes only. The steps required for building and running a Code Composer Studio project are explained next.

3.1.2 Overview

The software in Build1 has been configured so that the user can quickly evaluate the PWM driver module by viewing the related waveforms on a scope and observing the effect of duty cycle change on DC-DC output voltage. The user can adjust the PWM duty cycle from Code Composer Studio watch window. The user can also evaluate the ADC driver module by viewing the ADC sampled data in the watch window.

The PWM and ADC driver macro instantiations are executed inside the _DPL_ISR. Figure 7 shows the software blocks used in this build. The two PWM signals for the two BOOST switches are obtained from ePWM module 1 and 2. ePWM1A drives one of the BOOST switches while ePWM2A drives the other. The two PWM signals for the two LLC stage switches are obtained from ePWM module 3. ePWM3A drives the upper(high side) LLC switch while ePWM3B drives the low side switch.

The quantities that are sensed and fed back to the MCU include:

- The panel voltage (Vp_fb)
- The combined BOOST inductor current (IL)
• The boost DC bus voltage (Vb_fb)

These quantities are read using the ADC driver module and are indicated in Figure 7. The fourth channel for the ADC driver macro is not used in this application. The ADC driver module converts the 12-bit ADC result to a 32-bit Q24 value.

Figure 7. Build 1 Software Blocks

The boost PWM signals are generated at a frequency of 100 kHz (that is, a period of 10 µs). With the controller operating at 60 MHz, one count of the time base counter of ePWM1 corresponds to 16.6667 ns. This implies a PWM period of 10 µs is equivalent to 60 counts of the time base counter (TBCNT1, TBCNT2). The ePWM1 and ePWM2 modules are configured to operate in up-down count mode as shown in Figure 8. This means a time base period value of 300 (period register value) will give a total PWM period value of 600 counts (10 µs).

The LLC PWM signals are generated at a frequency of 120 kHz (that is, a period of 8.33 µs). With the controller operating at 60 MHz, one count of the time base counter of ePWM3 corresponds to 16.6667 ns. This implies a PWM period of 8.33 µs is equivalent to 500 counts of the time base counter (TBCNT3). The ePWM3 module is configured to operate in up-down count mode. This means a time base period value of 250 (period register value) will give a total PWM period value of 500 counts (8.33 µs).

BOOST inductor current is sampled at the midpoint of the PWM1A ON pulse since the sampled value represents the average inductor current under CCM (continuous conduction mode) condition. Under DCM condition this sampled current value represents a fraction of the average inductor current.

The other two voltage signal conversions are also initiated at this time. This is indicated in Figure 8. The flexibility of ADC and PWM modules on C2000 devices allow for precise and flexible ADC start of conversions. In this case, ePWM1 is used as a time base to generate a start of conversion (SOC) trigger when the TBCNT1 reaches zero. A dummy ADC conversion is performed at this point in order to ensure the integrity of the ADC results.
Figure 8. PWM Generation and ADC Sampling

On a CAU event (TBCNT1 = CMPA and counting up), ePWM1A output is Reset, while on a CAD event (TBCNT1 = CMPA and counting down), ePWM1A output is set. ePWM2A is also configured in a similar manner with 180 phase shift with respect to ePWM1A.

The CMPA value is derived from the input “BOOSTDuty” (Q24 variable) command.

The ADC module is configured to use SOCA of ePWM1 such that, SOCA is triggered at TBCNT1 = ZERO event. All conversions are completed using this SOCA trigger. These three ADC results are read in the ISR by executing the ADC driver module from the 50 kHz ISR labeled as _DPL_ISR.

This ISR in assembly (_DPL_ISR) is triggered by EPWM1 on a CMPB match event on up count. CMPB is set to 80 so that the ISR is triggered only after the ADC conversions are complete. This is where the PWMDRV_1ch_UpDwnCnt macros are executed and the PWM compare shadow registers updated. These are loaded in to the active register at the next TBCNT = ZERO event. Note that the ISR trigger frequency is half that of the PWM switching frequency as shown in Figure 8.

3.1.3 Protection

An overvoltage protection mechanism is implemented in software for this MPPT DC-DC EVM. This OVP applies only for the boost output and not for the LLC stage output. Since the Piccolo controller is on the primary side of the isolation it has no knowledge of the isolated LLC output. Therefore, the user must connect a minimum load of about 10W across the LLC output in order to make the open loop LLC output follow its input voltage, the output voltage from the boost stage. The minimum load across the LLC output helps maintain the LLC stage voltage conversion factor of 1. This way the max LLC output will also be limited by the max boost output, which in turn is protected by the OVP mechanism.

The sensed boost stage DC bus output voltage from the ADC input is compared against the overvoltage protection threshold set by the user. The default OV threshold set point is 404 V. This threshold parameter is programmed inside the file HV_SOLAR_DC_DCMain.h. This is done by the following initialization of the on-chip DAC reference voltage.

```
Comp3Regs.DACVAL.bit.DACVAL = 808;
```

Since the 10 bit DAC full scale value represents a max voltage of 511 V, the init value of 808 represents the OV threshold of 404 V.
In case of an OV condition the PWM outputs are duty limited pulse by pulse using the TZ (trip zone) registers. The flexibility of the trip mechanism on C2000 devices provides the possibilities for taking different actions on different trip events.

3.2 **Procedure**

3.2.1 **Start Code Composer Studio and Open a Project**

The following steps are used to quickly execute this build:

1. Connect USB connector to the Piccolo controller board for emulation.
2. Power up the 12 V bias supply at JP1. By default, the Piccolo control card jumpers (see the Piccolo controlCard documentation) are configured such that the device boots from Flash. Change these jumper settings to allow code execution from RAM under Code Composer Studio control.
3. Start Code Composer Studio. A project contains all the files and build options needed to generate an executable output file (.out) that can be run on the MCU hardware in Code Composer Studio.
4. Click Project → Import Existing CCS/CCE Eclipse Project on the menu bar. Under Select root directory → navigate to and select the directory: www.ti.com/controlsuite - (development_kits/MPPT DC-DC_v1.0/MPPT DC-DC). Make sure that MPPT DC-DC is checked under the Projects tab. Click Finish. This project invokes all the necessary tools (compiler, assembler and linker) for building the project.
5. In the project window on the left, click the plus sign (+) to the left of Project. Your project window looks like the one shown in Figure 9.

![Figure 9. Code Composer Studio Project Window](image)

3.2.2 **Device Initialization, Main, and ISR Files**

**NOTE:** *DO NOT* make any changes to the source files – **ONLY INSPECT.**

1. Open and inspect SOLAR_DC_DC-DevInit_F2803x.c by double clicking on the filename in the project window. Note that system clock, peripheral clock prescale, and peripheral clock enables have been setup. Note that the shared GPIO pins have been configured.
2. Open and inspect SOLAR_DC_DC-Main.c. Notice the call made to DeviceInit() function and other variable initialization. Also notice code for different incremental build options, the ISR initialization and the background for(;;) loop.

3. Locate and inspect the following code in the main file under initialization code specific for build 1. This is where the PWMDRV_1ch_UpDwnCnt and ADCDRV_1CH blocks are connected in the control flow.

```c
#pragma (INCR_BUILD == 1) // Open Loop Debug for Boost Stage; LLC stage always runs under open loop
#pragma (INCR_BUILD == 1),

// Connect the PWM Driver input to an input variable, Open Loop System
ADCDRV_1ch_Ptr1 = 4IL_raw;//Raw ADC data which seems to have some nonzero offset
ADCDRV_1ch_Ptr2 = 4Vb_fb;
ADCDRV_1ch_Ptr3 = 4Vp_fb;
ADCDRV_1ch_Ptr4 = 4ICm;

// Math_avg block connections - Instance 1
// MATH_EMAVG_Int4=4IL_raw;
MATH_EMAVG_In1=4IL_raw; // Input instantaneous IL after offset correction (correction done is ISR)
MATH_EMAVG_Out1=4IL_avg; // Output Avg IL after offset correction
MATH_EMAVG_Multiplier1=IQ30(0.030);

// Math_avg block connections - Instance 2
MATH_EMAVG_In2=4Vb_fb;
MATH_EMAVG_Out2=4Vb_fb_Avg;
MATH_EMAVG_Multiplier2=IQ30(0.00025);

PWMDRV_1ch_UpDwnCnt_Duty1 = 4DutyA;
PWMDRV_1ch_UpDwnCnt_Duty2 = 4DutyA;
PWMDRV_1ch_UpDwnCnt_Duty4 = 4DutyA;

// Initialize the net variables
DutyA = IQ24(0.1); // Variable initialized for open loop test of the DC-DC Boost Stage
DutyLLC = IQ24(0.5);
DutyA4A = IQ24(0.0); 
IL_avg = IQ24(0.0);
IL = IQ24(0.0);
IL_raw = IQ24(0.0);
Vb_fb_Avg = IQ24(0.0);
#endif
```

4. Locate and inspect the following code in the main file under initialization code. This is where the PWMDRV_1ch_UpDwnCnt block is configured and initialized. This is common for all incremental builds. This PWM driver module inputs the total PWM period value of 600 and internally calculates the period register value of 300.

```c
#define period 600 //600 cycles -> 100KHz @6MHz CPU, PWM period for 2Ph Interleaved Boost stage
#define phase 300 //Phase shift for slave PWM in 2Ph IL Boost stage
#define period_LL 500 //545->110KHz, 460->130KHz, 500 cycles -> LLC freq 120KHz @6MHz CPU
#define period_pll_no_load 460 //460->130KHz, -> LLC freq 130KHz @6MHz CPU
#define period_pll_intrinsic_pll 150 //150 -> 500K @6MHz CPU, period for PLL channels used for instrumentation

// Configure PWM for 100KHz switching frequency
PWM_UpdLcn_CNF(1,period_LL,1,0);
// Configure PWM for 100KHz switching frequency
PWM_UpdLcn_CNF(2,period,0,300);

PWM_ComplPair_DB_CNF(2,period_pll_no_load,1,0);
PWM_ComplPair_DB_CNF(1,period_pll_intrinsic_pll,1,0);
```

5. Locate and inspect the following code in the main file under initialization code. This is where the ADCDRV_1CH block is configured and initialized. This is also common for all incremental builds.
6. Open and inspect SOLAR_DC_DC-DPL-ISR.asm. Notice the _DPL_Init and _DPL_ISR sections under build 1. This is where the PWM and ADC driver macro instantiation is done for initialization and runtime, respectively.

3.2.3 Build and Load the Project

1. Select the incremental build option as 1 in the SOLAR_DC_DC-Settings.h file.

   **NOTE:** Whenever you change the incremental build option in SOLAR_DC_DCSettings.h always do a “Rebuild All”.

2. Click the Project → “Rebuild All” button and watch the tools run in the build window.

3. Click Target → "Debug Active Project". Code Composer Studio asks you to open a new Target configuration file if one hasn’t already been selected. If a valid target configuration file has been created for this connection you can jump to Step 1 (in Section 3.2.5). In the New target Configuration Window, type in the name of the .ccxml file for the target you will be working with (example: xds100-F28035.ccxml). Check “Use shared location” and click Finish.

4. Select Connection as “Texas Instruments XDS100v2 USB Emulator” in the .ccxml file that opens up. Under the device, scroll down and select “TMS320F28035”. Click Save.

5. Click Target → "Debug Active Project". Select project configuration as F2803x_FLASH. The program will be loaded into the FLASH. You should now be at the start of Main().

3.2.4 Debug Environment Windows

It is standard debug practice to watch local and global variables while debugging code. There are various methods for doing this in Code Composer Studio, such as memory views and watch views. If a watch view did not open when the debug environment was launched, open a new watch view and add various parameters to it by following the procedure given below.

1. Click View → Watch on the menu bar.

2. Click the "Watch (1)" tab at the top watch view. You may add any variables to the watch view.

3. Type the symbol name of the variable you want to watch in the empty box in the "Name" column and press enter on the keyboard. Be sure to modify the “Format” as needed.
### 3.2.5 Using Real-Time Emulation

Real-time emulation is a special emulation feature that allows the windows within Code Composer Studio to be updated at a rate up to 10 Hz while the MCU is running. This not only allows graphs and watch views to update, but also allows the user to change values in watch or memory windows, and see the effect of these changes in the system.

1. Enable real-time mode by hovering the mouse on the buttons on the horizontal toolbar and clicking the **Enable Silicon Real-Time Mode** - service critical interrupts when halted, allow debugger accesses while running) button.

2. A message box may appear. If so, select YES to enable debug events. This will set bit 1 (DGBM bit) of status register 1 (ST1) to a “0”. The DGBM is the debug enable mask bit. When the DGBM bit is set to “0”, memory and register values can be passed to the host processor for updating the debugger windows.

3. Click on the **Watch View** for the watch view.

### 3.2.6 Run the Code

1. Run the code by using the <F8> key, or using the Run button on the toolbar, or using Target → Run on the menu bar.

2. Add the variable DutyA and set it to 0.1 (=1677721 in Q24) in the watch view. This variable sets the duty cycle for the boost converter.

3. Apply a resistive load to the DC-DC EVM output terminal (10~100W).

4. Use a high voltage isolated DC supply to power the DC-DC EVM. Measure and verify the boost DC bus voltage corresponding to applied input voltage and the duty ratio.

5. Use Duty A to slowly change the duty from the watch window. The boost converter output voltage should change accordingly and this, in turn, will change the EVM output. Observe the output voltage carefully, this should not be allowed to exceed the maximum voltage rating of the board.

6. Add the other variables such as, Vb_fb, Vp_fb and verify the different ADC results in the watch view.

7. The following oscilloscope captures show two PWM outputs (Ch1 and Ch2), DC source input current (Ch3) and Boost MOSFET drain to source voltage (Ch4) when the output DC bus load is 1K Ω, input DC voltage is 250V and the set duty ratio is about 10%. The PWM frequency is measured as 100 kHz.
8. The following oscilloscope captures show two PWM outputs (Ch1 and Ch2) for the LLC stage. In this figure Ch4 represents LLC stage primary switch node voltage and Ch3 is the LLC primary current when the boost input is 250 V, boost output (LLC input) is 300 V, LLC output is 307 V, LLC output load is 1K Ω and the boost duty ratio is set to about 10%.
9. Try different duty cycle values and observe the corresponding ADC results. Increase duty cycle value in small steps. Always observe the output voltage carefully, this should not be allowed to exceed the capabilities of the board. Different waveforms, like the PWM gate drive signals, input voltage and current and output voltage may also be probed and verified using an oscilloscope. Appropriate safety measures must be taken while probing these high voltage signals.

10. Fully halting the MCU when in real-time mode is a two-step process. With the DC input turned off wait until the DC bus capacitor is fully discharged. First, halt the processor by using the Halt button on the toolbar, or by using Target → Halt. Then take the MCU out of real-time mode. Finally reset the MCU.

11. You can leave Code Composer Studio running for the next exercise or close it.

3.3 **Build 2 - MPPT DC-DC With Closed Current Loop**

#### 3.3.1 Objective

The objective of this build is to verify the operation of the MPPT DC-DC under closed current loop and open voltage loop mode. Since the voltage loop is open, there is no MPPT operation under this build.

#### Overview

Figure 10 shows the software blocks used in this build. Notice that one additional software block is compared to the Build 1 diagram (Figure 7). This block is shown in Figure 10 as CNTL_2P2Z:1. It represents a 2-pole 2-zero (2p2z) controller and is used for the current control loop. Depending on the control loop requirements other control blocks such as a PI or a 3p3z controller can also be used.

As shown in Figure 10, the current loop control block is executed at a 50 KHz rate. CNTL_2P2Z is a second order compensator realized from an IIR filter structure. This function is independent of any peripherals and therefore does not require a CNF function call.
This 2p2z controller requires five control coefficients. These coefficients and the clamped output of the controller are stored as the elements of a structure named `CNTL_2P2Z_CoefStruct1`. The `CNTL_2P2Z` block can be instantiated multiple times if the system needs multiple loops. Each instance can have separate set of coefficients. The `CNTL_2P2Z` instance for the current loop uses the coefficients stored as the elements of structure `CNTL_2P2Z_CoefStruct1`. This way a second instantiation of `CNTL_2P2Z` with a different structure, `CNTL_2P2Z_CoefStruct2`, can be used for voltage loop control, as you will see in the next section with Build 3.

The controller coefficients can be changed directly by modifying the values for B0, B1, B2, A1, and A2 inside the structure `CNTL_2P2Z_CoefStruct1`. Alternately, the 2p2z controller can be expressed in PID form and the coefficients can be changed by changing the PID coefficients. The equations relating the five controller coefficients to the three PID gains are shown below. For the current loop these P, I and D coefficients are named as: Pgain_I, Igain_I and Dgain_I respectively. For the voltage loop, used in Build 3, these coefficients are named as: Pgain_V, Igain_V and Dgain_V, respectively. These coefficients are used in Q26 format.

The compensator block (`CNTL_2P2Z`) has a reference input and a feedback input. The feedback input labeled as, `Fdbk`, comes from the ADC. The reference input labeled as, `Ref`, normally comes from the voltage loop controller output. But, in this build there is no voltage loop controller and so the variable `Boost_IL_cmd` is used to change the reference current under user control. The z-domain transfer function for `CNTL_2P2Z` is given by:

\[
\frac{U(z)}{E(z)} = \frac{b_0 + b_1 z^{-1} + b_2 z^{-2}}{1 + a_1 z^{-1} + a_2 z^{-2}}
\]  

(1)

The recursive form of the PID controller is given by Equation 2:

\[
u(k) = u(k - 1) + b_0 e(k) + b_1 e(k - 1) + b_2 e(k - 2)
\]  

(2)

where,

\[
b_0 = K_p + K_i + K_d
\]

\[
b_1 = K_p + K_i - 2K_d
\]

\[
b_2 = K_d
\]  

(3)

and, the z-domain transfer function of this PID is:

\[
\frac{U(z)}{E(z)} = \frac{b_0 + b_1 z^{-1} + b_2 z^{-2}}{1 + z^{-1}}
\]  

(4)

Comparing this with the general form, you can see that PID is a special case of CNTL_2P2Z control, where,

\[a_1 = -1\quad \text{and}\quad a_2 = 0\]

(5)

The exponential moving average (MATH_EMAVG) blocks shown in Figure 10 calculate the average of the boost inductor current and the panel voltage. The average inductor current represents the panel current and is used to implement the MPPT algorithm.

### 3.4 Procedure

#### 3.4.1 Build and Load Project

Follow step 1 (from Section 3.2.1) through step 5 (from Section 3.2.2) exactly as in build 1 (Section 3.1) except that in step 6 select the build 2 option instead of build 1. Then complete step 6 as shown below.

Locate and inspect the following code in the main file under initialization code specific for build 2. This is where all the software blocks related to build 2 are connected in the control flow.
1. Open and inspect SOLAR_DC_DC-DPL-ISR.asm. Notice the _DPL_Init and _DPL_ISR sections under build 2. This is where all the macro instantiations under build 2 are done for initialization and runtime, respectively.

2. Select the Incremental build option as 2 in the SOLAR_DC_DC-Settings.h file. Then follow steps 2 (from Section 3.2.3) through 1 (from Section 3.2.6) as in build 1 in order to run the code. When all these steps are completed you should now be at the start of Main().

**NOTE:** Always do a “Rebuild All” whenever you change the incremental build option in SOLAR_DC_DCSettings.h.

3. Run the code by using the <F8> key, or using the Run button on the toolbar, or using Target → Run on the menu bar.

4. In the watch view, add the variable Boost_IL_cmd and set it to 0.05 (=838861 in Q24). This variable sets the magnitude of the reference current command for the current control loop.

5. Connect an appropriate resistive load across the DC-DC output. For example, an 1.0KΩ resistor of 400W rating can be used. This provides a load of 160W at 400 V bus voltage.

6. Slowly apply DC power to the board from an isolated DC source. Monitor the DCDC EVM output voltage as the input voltage is raised slowly to 300 V. Slowly adjust (in steps of 0.01) the value for Boost_IL_cmd to set the output voltage to about 385 V. Use an oscilloscope with voltage and current probes to observe the input voltage, input current, boost MOSFET voltage, LLC primary current and the PWM outputs. With a 300 V boost input and 1.0kΩ resistive load when the boost output voltage is set to 373 V you should see the LLC output voltage (EVM output) of 385 V. The following scope plot is captured under this condition. Here Ch1 and Ch2 show the boost PWM outputs. Ch3 is the boost input current and Ch4 is the voltage across the boost MOSFET.
7. Increase $Boost_{IL\_cmd}$ slightly (in steps of 0.01) and observe the bus voltage settles to a higher value. Increasing $Boost_{IL\_cmd}$ increases the magnitude of the current reference signal and the bus voltage will rise. Therefore, apply caution and set the overvoltage protection threshold to a value less than 400 V.

8. Follow steps 11 and 12 (from Section 3.2.6) to turn off power and reset the MCU.

3.5 **Build 3: MPPT DC-DC With Closed Voltage and Current Loop**

3.5.1 **Objective**

The objective of this build is to verify the operation of the complete MPPT DC-DC project from the Code Composer Studio environment.

3.5.2 **Overview**

Figure 12 shows the software blocks used in this build. Compared to build 2 in Figure 10, this build uses an additional 2p2z control block labeled as $CNTL_{2P2Z:2}$. This is the second instantiation of the 2p2z control block in order to implement the MPPT DC-DC voltage loop control. This voltage loop controller is executed at 25 kHz rate that is half the rate for the current loop. The output from this control block drives the input node $Boost_{IL\_cmd}$ of the current controller block.
Similar to current loop controller, this voltage loop controller, \textit{CNTL\_2P2Z\_2}, also requires five control coefficients. These coefficients and the clamped output of the controller are stored as the elements of a second structure named \textit{CNTL\_2P2Z\_CoefStruct2}. The coefficients for this controller can be changed directly by modifying the values for \text{B0}, \text{B1}, \text{B2}, \text{A1}, and \text{A2} inside the structure \textit{CNTL\_2P2Z\_CoefStruct2}, or by changing the equivalent PID gains as discussed in Section 3.3.

\textbf{Figure 12} also shows two additional blocks implementing two different MPPT algorithms that are used in this EVM. The default code setting uses incremental conductance algorithm for the MPPT and so the output from this MPPT block is connected to the feedback terminal (Fdbk) of the voltage loop controller. These MPPT blocks are run from a 10kHz ISR.

\section{Procedure}

\subsection{Build and Load Project Follow}

Follow step 1 (from Section 3.2.1) through step 5 (from Section 3.2.2) exactly as in build 1 (Section 3.1) except that in step 6 select the build 3 option instead of build 1. Then complete step 6 as shown below.

Locate and inspect the following code in the main file under initialization code specific for build 3. This is where all the software blocks related to build 3 are connected in the control flow.
1. Open and inspect SOLAR_DC_DC-DPL-ISR.asm. Notice the _DPL_Init and _DPL_ISR sections under build 3. This is where all the macro instantiations under build 3 are done for initialization and runtime, respectively.

2. Select the Incremental build option as 3 in the SOLAR_DC_DCSettings.h file. Then follow steps 2 (from Section 3.2.3) through 1 (from Section 3.2.6) in build 1 in order to run the code. When all these steps are completed you should now be at the start of Main().

   **NOTE:** Always do a “Rebuild All” whenever you change the incremental build option in SOLAR_DC_DC-Settings.h.

3. Run the code by using the <F8> key, or using the Run button on the toolbar, or using Target → Run on the menu bar.

4. In the watch view, add four variables inverter_connected, Start_DC_DC, Vp_fb, and Vb_fb. Set the Q-format for the last two variables (Vp_fb and Vb_fb) to Q24. These two variables represent the boost input and output voltages respectively. These will slowly increase as the DC-DC starts up when PV panel emulator power is applied and the MPPT is turned on. To start MPPT from Code Composer Studio (under this build) first, the user needs to modify the code as explained in step 6 below and reload the program to flash memory. Then, from the Code Composer Studio watch window, the user will set the variables Start_DC_DC to 1 and inverter_connected to 0.

5. Configure a solar panel emulator (200 V to 300 V, 500W max) to provide input power to the EVM. Configure the panel emulator to emulate the following solar panel characteristics; connect it to the EVM input but do not turn on panel power at this time.

   **Example Panel Emulator Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voc</td>
<td>260 V</td>
</tr>
<tr>
<td>Vmpp</td>
<td>220 V</td>
</tr>
<tr>
<td>Imppp</td>
<td>0.75A</td>
</tr>
<tr>
<td>Isc</td>
<td>1 A</td>
</tr>
</tbody>
</table>

   **Example Panel Emulator Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voc</td>
<td>260 V</td>
</tr>
<tr>
<td>Vmpp</td>
<td>220 V</td>
</tr>
<tr>
<td>Imppp</td>
<td>0.75A</td>
</tr>
<tr>
<td>Isc</td>
<td>1 A</td>
</tr>
</tbody>
</table>
Connect an appropriate resistive load to the EVM output terminals (Vo-R and GND terminals). As in the example above, if the panel emulator is configured to supply 165W of power at MPPT point, then select a load resistor value of 970 Ω so that the EVM output voltage is limited to about 400 V \( (P = 400 \times 400/970 \approx 165W) \). A smaller resistor will also work as long as the output voltage does not fall below 350 V. This means that the smallest resistor that can be chosen for this load set up (165W) is about 742 Ω \( (R = 350 \times 350/165 = 742 \, \Omega) \). A resistor value larger than 970 Ω will cause output voltage higher than 400 V for this load set up. This output overvoltage condition must be prevented by choosing the maximum resistor value of 970 Ω for this load set up of 165W. It is recommended that the resistor with a power rating > 200W is used for this load setting.
6. Starting the MPPT algorithm (in build 3) from Code Composer Studio watch window, with the PV panel emulator power applied to the EVM input, requires changing one line of code as explained below. Without this change, the code automatically starts the MPPT algorithm when:

(a) The minimum panel input voltage is applied
(b) From the GUI, the user sets the variable inverter_connected to 0.

When the EVM is shipped, the default code loaded in the Flash memory allows this GUI-based power up in standalone mode. Therefore, this code modification is needed only if the user wants to start the MPPT from the Code Composer Studio watch window.

Open the Code Composer Studio project file HV_Solar_DC_DC-Main.c and locate the code where the variable Start_DC_DC is set to 1 as shown below.

```c
void StartDCDC()
{
    if (INCBUILD == 3) {
        //When the DC-DC runs without the Inverter, check for min panel voltage before starting MPPT DC-DC.
        //If DC-DC runs with the Inverter connected, this flag (Start_DC_DC) is not used. Another GPIO (GPIO6)
        //is used to turn on (activated by the Inverter) to start the DC-DC.
        if ((inverter_connected == 1) && (Start_DC_DC == 1)) {
            //To control the variable "Start_DC_DC" from CCU switch window and run the DC-DC code with external 1V bias (not using PERIOD time avg)
            //COMMENTS OFF the line above. This will allow code to run with MPPT off. Then the user can apply panel volt and start MPPT
            //from CCU (check window) by setting Start_DC_DC = 1
            //-------------------------------------------------------------------------------
            Start_DC_DC 1 = Start_DC_DC
        } else {
            Start_DC_DC = 0; //Do not start DC-DC MPPT
        }
    } //if (INCBUILD == 3)
    if (GPIO_status == 0) {
        A_Temp_Pct = 444;
    } else {
        //-------------------------------------------------------------------------------
        //the next time CpuTimer0 'counter' reaches Period value go to A1
        A_Temp_Pct = 443;
    }
}
```

Figure 13. Sample Code

Comment out this one line of code, save the file, recompile and reload the project in the flash memory. Follow steps 1 through 3 (from Section 3.6.1) and run the code. Enable the real-time mode and then click on the for the watch view. The variables Start_DC_DC will be set to 0 and inverter_connected will be set to 1.

7. Use a voltmeter to monitor the DC bus voltage across the EVM output. Now turn on the PV panel emulator with the setup described in step 5. At this point the MPPT still remains off so the EVM input should be around 260 V and the output voltage, with a 1kΩ load resistor, will also be at the same level. From the Code Composer Studio watch window, set the variables inverter_connected to 0 and Start_DC_DC to 1. This starts the MPPT algorithm and the EVM output rises to around 400 V. With the MPPT turned on and the input voltage loop controller connected, the panel output voltage (the boost input voltage) will be around 220 V. The EVM delivers 165W of panel power (as described in step 5) at the MPPT reference voltage of 220 V.

Use an oscilloscope to capture the switch node voltage and transformer primary current from the LLC stage under this operating condition. This is shown in Figure 14 where Ch2 represents the LLC primary switch node voltage and Ch1 represents the LLC primary current.
Now use the scope probes to capture the boost stage MOSFET drain to source voltage and the PV emulator current under this operating condition. This is shown in Figure 15 where Ch2 represents the boost MOSFET drain to source voltage and Ch4 represents the panel current.
Observe the variables on the watch window. The variable Vp_fb should show a value of about 0.4297 (≈220/512) when the Q format is set to Q24. The maximum panel voltage set by the sense resistors is about 512V that corresponds to maximum ADC input of 3.3V. Therefore, the normalized or per unit value will be about 0.4297 when the actual panel voltage is 220 Vdc. The variable Vb_fb should show a value of about 0.7813 (≈400/512) when the Q format is set to Q24. The maximum boost output voltage set by the sense resistors is about 512 V that corresponds to maximum ADC input of 3.3 V. Therefore, the normalized or per unit value will be about 0.7813 when the actual boost output voltage is 400 Vdc.

8. Follow step 1 (from Section 3.2.1) through step 5 (from Section 3.2.2) to turn off power and reset the MCU. Undo the change in code performed in step 6, then recompile and reload the code into the Flash memory for the standalone operation of the EVM. Set the Piccolo controlCard jumpers (see Piccolo controlCard documentation) appropriately such that the device can boot from FLASH.

4 References

- www.ti.com/controlsuite:
  - MPPT DC-DC-GUI-QSG – A quick-start guide for quick demo of the MPPT DC-DC EVM using a GUI interface.
    ...\development_kits\HV_SOLAR_DC-DC\~Docs\QSG_HV_SOLAR_DC_DC_GUI_Rev1.0.pdf
  - MPPT DC-DC_Rel-1.0-HWdevPkg – A folder containing various files related to the Piccolo-B controller card schematics and the MPPT DC-DC schematic.
    ...\development_kits\HV_SOLAR_DC-DC\HV_SOLAR_DC-DC_HWDevPkg
IMPORTANT NOTICE

Texas Instruments Incorporated and its subsidiaries (TI) reserve the right to make corrections, enhancements, improvements and other changes to its semiconductor products and services per JESD46, latest issue, and to discontinue any product or service per JESD48, latest issue. Buyers should obtain the latest relevant information before placing orders and should verify that such information is current and complete. All semiconductor products (also referred to herein as “components”) are sold subject to TI’s terms and conditions of sale supplied at the time of order acknowledgment.

TI warrants performance of its components to the specifications applicable at the time of sale, in accordance with the warranty in TI’s terms and conditions of sale of semiconductor products. Testing and other quality control techniques are used to the extent TI deems necessary to support this warranty. Except where mandated by applicable law, testing of all parameters of each component is not necessarily performed.

TI assumes no liability for applications assistance or the design of Buyers’ products. Buyers are responsible for their products and applications using TI components. To minimize the risks associated with Buyers’ products and applications, Buyers should provide adequate design and operating safeguards.

TI does not warrant or represent that any license, either express or implied, is granted under any patent right, copyright, mask work right, or other intellectual property right relating to any combination, machine, or process in which TI components or services are used. Information published by TI regarding third-party products or services does not constitute a license to use such products or services or a warranty or endorsement thereof. Use of such information may require a license from a third party and is subject to the terms and conditions of sale of semiconductor products. Nonetheless, such components are subject to these terms.

Resale of TI components or services with statements different from or beyond the parameters stated by TI for that component or service voids all express and implied warranties for the associated TI component or service and is an unfair and deceptive business practice. TI is not responsible or liable for any such statements.

Buyer acknowledges and agrees that it is solely responsible for compliance with all legal, regulatory and safety-related requirements concerning its products and any use of TI components in its applications, notwithstanding any applications-related information or support that may be provided by TI. Buyer represents and agrees that it has all the necessary expertise to create and implement safeguards which anticipate dangerous consequences of failures, monitor failures and their consequences, lessen the likelihood of failures that might cause harm and take appropriate remedial actions. Buyer will fully indemnify TI and its representatives against any damages arising out of the use of any TI components in safety-critical applications.

In some cases, TI components may be promoted specifically to facilitate safety-related applications. With such components, TI’s goal is to help enable customers to design and create their own end-product solutions that meet applicable functional safety standards and requirements. Nonetheless, such components are subject to these terms.

No TI components are authorized for use in FDA Class III (or similar life-critical medical equipment) unless authorized officers of the parties have executed a special agreement specifically governing such use.

Only those TI components which TI has specifically designated as military grade or “enhanced plastic” are designed and intended for use in military/aerospace applications or environments. Buyer acknowledges and agrees that any military or aerospace use of TI components which have not been so designated is solely at the Buyer’s risk, and that Buyer is solely responsible for compliance with all legal and regulatory requirements in connection with such use.

TI has specifically designated certain components as meeting ISO/TS16949 requirements, mainly for automotive use. In any case of use of non-designated products, TI will not be responsible for any failure to meet ISO/TS16949.

<table>
<thead>
<tr>
<th>Products</th>
<th>Applications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio</td>
<td>Automotive and Transportation</td>
</tr>
<tr>
<td>Amplifiers</td>
<td>Communications and Telecom</td>
</tr>
<tr>
<td>Data Converters</td>
<td>Computers and Peripherals</td>
</tr>
<tr>
<td>DLP® Products</td>
<td>Consumer Electronics</td>
</tr>
<tr>
<td>DSP</td>
<td>Energy and Lighting</td>
</tr>
<tr>
<td>Clocks and Timers</td>
<td>Industrial</td>
</tr>
<tr>
<td>Interface</td>
<td>Medical</td>
</tr>
<tr>
<td>Logic</td>
<td>Security</td>
</tr>
<tr>
<td>Power Mgmt</td>
<td>Space, Avionics and Defense</td>
</tr>
<tr>
<td>Microcontrollers</td>
<td>Video and Imaging</td>
</tr>
<tr>
<td>RFID</td>
<td></td>
</tr>
<tr>
<td>OMAP Applications Processors</td>
<td>TI E2E Community</td>
</tr>
<tr>
<td>Wireless Connectivity</td>
<td></td>
</tr>
</tbody>
</table>

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2015, Texas Instruments Incorporated